Description

Simple Building
Slab Design

For LUSAS version: 24.0

For software product(s): | LUSAS Civil & Structural or LUSAS Bridge.

With product option(s): | RC Slab Design

Note: The example as written exceeds the limits of the LUSAS Teaching and
Training Version. However, by not increasing the default mesh density to 8 divisions
per line (where shown) the analysis can be run using a default of 4 divisions per line.

Description

Four panels of a concrete slab Line Support B
supported by a wall, columns and a Panl A Pancl B
lift shaft are to be analysed, with
reinforcement areas computed for

1 Slab Thickness 250mm m
b'endmg moment only. Shear and Curcrete 40 M 6
displacement checks need to be Steel 460 N/mm?
carried out separately. The geometry Columns
of the slab is as shown.

] ]

The slab is subjected to self-weight Panel C Panel D

and a live load.

4.‘

The units of the analysis are N, m, ZE ></ gi{,‘;’pms o
kg, s, C throughout.
f—2m—f
Objective (] ] ] =
U To produce utilisation plots i 6m - 6r |

under ultimate loads and
check the locations of cracking under service loads
Keywords

2D, Plate Elements, Slab Design, Holes, Reinforcement, Wood-Armer, RC Design, Steel
Area, Load Combinations, Smart Combinations, SLS, ULS, Beneficial, Adverse, Cracking
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Simple Building Slab Design

Associated Files

Associated files can be downloaded from the user area of the LUSAS website.

U slab_design_modelling.lvb carries out the modelling of this example.

Running LUSAS Modeller

For details of how to run LUSAS Modeller, see the heading Running LUSAS
Modeller in the Introduction to LUSAS Worked Examples document.

Note. This example is written assuming a new LUSAS Modeller session has been
started. If continuing from an existing Modeller session select the menu command
File>New to start a new model file. Modeller will prompt for any unsaved data and
display the New Model dialog.

Creating a new model

e Enter the file name as Slab_Design

e Enter a file path for the working folder.

e Set the Analysis type to be Structural

e Set the Analysis Category to be 2D Grillage/Plate

o Select model units of N,m,kg,s,C

¢ Ensure the timescale units are Seconds

o Select the Startup template None from those available in the drop-down list.
e Enter the title as Slab Design Example

e Leave Layout grid set to None and click the OK button.

Note. The Analysis category determines which elements will be available for
modelling. Here we are only interested in the out-of-plane bending effects in a flat slab
and therefore we can approximate this behaviour with 2D plate elements.

Note. Save the model regularly as the example progresses. Use the Undo button to
correct any mistakes made since the last save was done.




Modelling

Feature Geometry

Geomet
| eg’?ﬁa; s _I De-select the 3 Columns grid style check box and
By Coords... enter coordinates of (0, 0), to define the lower left-
hand area of slab, and using the Tab key to move to

the next entry field enter coordinates of (6, 0), (6, 6)

and (0, 6).

e With all the coordinates entered click the OK
button to create a surface.

o Select the newly created Surface.

lGeg)LTﬁZt(Z S M Copy the selected surface with an X translation of
Copy... 6.

e Click the OK button to create the new Surface.

e Use Ctrl + A keys together to select the whole
model.

lGeg)LTﬁZt(Z S M Copy the selected surfaces with a Y translation of
Copy... 6.

e Click the OK button to define two new Surfaces.

Defining a Hole in a Slab

Next, a hole representing the lift shaft needs to be defined. This is done by first creating

a surface representing the extent of the lift shaft and then selecting both the surrounding

and inner surface to define the hole.

Geomet
| S S _I Enter coordinates of (2, 2), (4, 2), (4, 4) and (2,
By Coords... 4) and click OK to define the extent of the hole.

e Select the lower left Surface and then the Surface
representing the lift shaft. (Use the Shift key to
pick the second Surface to add to the selection)

| Geometry e Ensure Delete geometry defining holes is
Sul:fa::e > selected. A new singular Surface will be created. S
oles >
Create




Model Properties. . .

| Attributes
Mesh >
Surface...

| Attributes
Mesh >
Line...

Simple Building Slab Design

This new surface containing the hole can be seen / checked by clicking in a blank part
of the View Window and then re-selecting the lower-left hand surface.

Note. It is normally good practice to ensure that the orientation of surface axes (and
hence mesh element orientation) is consistent throughout the model. However, plate
elements, as used in this example, produce results based upon global axes and as such
ignore inconsistent element axes.

Meshing

By default, lines normally have 4 mesh divisions per line. For this example, and to give
greater accuracy, 8 divisions per line will be used.

Note. If you are using the Teaching and Training version this default value should be
left unaltered to create a surface element mesh within the limit available. This will give
a coarser mesh and slightly less accurate results.

o Select the Meshing tab and set the default number of divisions to 8 and click the
OK button.

o Select the element type as Thick Plate, the element shape as Quadrilateral and the
interpolation order as Quadratic. Select an Irregular mesh and ensure the
Element size is deselected. This forces the number of default line mesh divisions to
be used when meshing the surfaces. Enter the attribute name as Thick Plate and
click the OK button.

o With the whole model selected drag and dlg

the mesh attribute Thick Plate from the
Treeview onto the selected Surfaces

In the vicinity of the lift core less elements are
required.

e Select the element type as None and enter the
Number of divisions as 4. Enter the attribute
name as Divisions=4 and the OK button sy

e Select the 4 lines defining the lift core and drag
and drop the line mesh attribute Divisions=4

from the & Treeview onto the selected Lines.

In this manner the mesh density on slabs can be varied according to the levels of detail
required.




| Attributes
Geometric >
Surface...

| Attributes

|Materia| >
Concrete (RC
frame / slab

design)...

| Attributes

Support...

Modelling

Geometric Properties

Enter a thickness of 0.25. Enter the attribute name as Thickness 250mm and click
the OK button.

With the whole model selected drag and drop the geometric attribute Thickness

250mm from the & Treeview onto the selected Surfaces. Click OK to assign to the
selected features for Analysis 1.

Geometric properties are visualised by default.

ﬂ Select the fleshing on/off button to turn-off the geometric visualisation.

Material Properties

On the RC Material dialog ensure that Country is set to Europe and Design code is
set to EN1992.

On the drop list for Concrete section select New.
On the dialog that appears select grade C40/50 and click OK.
On the RC Material dialog for the drop list for Reinforcement select New.

On the dialog that appears select grade S00B and click OK. Click OK on the RC
Material dialog.

Select the whole model and drag and drop the material attribute Matl (EN1992)
from the 6% Treeview onto the selected Surfaces.

Supports
Select Fixed for Translation in Z and enter the [ 77 777" 777" "7 7" 1777777777
attribute name Fixed in Z and click OK. ﬁg:ﬁg :}‘edse

For clarity the mesh layer is not shown on these

assign Fixed in Z

diagrams. ﬁ s &

Select the 6 points where the columns are located.

Assign the supports by dragging and dropping the

support attribute Fixed in Z from the €® L/] { s &
Treeview and assign to Points for All analysis </ ‘

loadcases by clicking the OK button.




| Attributes

Loading...

| Attributes

Loading...

Simple Building Slab Design

El Select the isometric view ) ,'Hﬂ

button to check that all supports ,m’ﬁ
) Pl

have been assigned correctly. f,mf

ZMA T Click this part of the

Select the 2 Lines representing the line support
and drag and drop the support attribute Fixed in H

Z from the P Treeview and assign to Lines for Select these 2
All analysis loadcases by clicking the OK  p7esandassion
button.

Select only the top, bottom and left-hand lines SdetieEas
defining the lift shaft and drag and drop the ,_:::SC angs;sign
support attribute Fixed in Z from the oo S FixedinZ
Treeview and assign to Lines for All analysis
loadcases by clicking the OK button. ””*

status bar to view the model from T ff‘[x%‘[\‘mﬂﬂ T
the Z direction (plan view) again. e Tj oo
e
Loading
o Select Body force, viscous support loading then Body force and click Next.

Enter an acceleration of -9.81 in the Z direction.

Enter an attribute name of Self Weight and click the Finish button.
Select Distributed loads, then Global Distributed and click Next.
Select the Per unit area option.

Enter -3000 in the Z Direction.

Enter the attribute name as Imposed Load 3kN/m2 and click the Finish button.

Now the dead and live loading needs to be assigned.

In the Analyses C Treeview, right click on Loadcase 1, select the Rename option
and change the loadcase name to Permanent




| File

Running the Analysis

Save

e With the whole model selected, assign the
dead loading by dragging and dropping
the attribute Self Weight from the
Treeview onto the selection. The loading
assignment dialog will be displayed.
Select the Single Loadcase option, the
analysis Analysis 1 and loadcase
Permanent, then click the OK button.

e With the whole model still selected, drag
and drop the dataset Imposed Load
3kN/m2 from the 6® Treeview onto the
selection, accepting all defaults, and
change the loadcase name to Variable and click the OK button.

Saving the model
El Save the model file.

Running the Analysis

&

With the model loaded:

El Select the Solve Now button from the toolbar and click OK to run the analysis.

A LUSAS Datafile will be created from the model information. LUSAS Solver uses
this datafile to perform the analysis.

If the analysis is successful...
Analysis loadcase results are added to the (X Treeview.
In addition, these files will be created in the LUSASFiles\<model name> folder:

U slab_design.out this output file contains details of model data, assigned
attributes and selected statistics of the analysis.
U slab_design.mys this is the LUSAS results file which is loaded

automatically into the (B Treeview to allow results processing to take place.

If the analysis fails...

If the analysis fails, information relating to the nature of the error encountered can be
written to an output file in addition to the text output window. Any errors listed in the
text output window should be corrected in LUSAS Modeller before saving the model
and re-running the analysis.



| File
New...
| File
Script >
Run Script...

Simple Building Slab Design

Rebuilding a Model

If it proves impossible for you to correct the errors reported a file is provided to enable
you to re-create the model from scratch and run an analysis successfully. You may
download this file from the user area of the LUSAS website.

U slab_design _modelling.lvb carries out the modelling of the example.

gl Start a new model file. If an existing model is open Modeller will prompt for
unsaved data to be saved before opening the new file.

e Enter the file name as Slab Design

e Use the default User-defined working folder.
e Ensure an Analysis type of 2D Inplane is set.
e Click the OK button.

Note. There is no need to enter any other new model details when a script is run to
build a model, since the contents of the script will overwrite any other settings made.

e To recreate the model, select the file slab_design_modelling.lvb that was
downloaded and placed in a folder of your choosing.

;l Solve the model to generate the results.

Viewing the Resulits

Analysis loadcase results are present in the (5 Treeview and loadcase results for the
last solved loadcase are set to be active by default.

e In the & Treeview, turn off the display of the Attributes layer.

The Geometry layer is to be retained to allow assignment of reinforcement layout to
surfaces in the model.

e In the C Treeview right-click on results loadcase Permanent and choose Set
active

e With no features selected, click the right-hand mouse button in a blank part of the

active window and select the Contours option to add the contours layer to the
Treeview.




Viewing the Results

Select entity
Force/Moment —
Thick Plate and
results component
MX and click OK
to see the results
for Permanent
effects in the slab
in the global X
direction.

Select entity
Force/Moment —
Thick Plate and
results component
MY and click OK
to see the results
for Permanent
effects in the slab
in the global Y
direction.

Analysis: Analysis 1

Loadcase: 1:Permanent

Results file: Slab_Design~Analysis 1.mys

Entity: Force/Moment - Thick Plate

Component (Averaged nodal): MX (Units: N.m/m)

-231712E3
-11.5856E3
0.0

11 5856E3
23172E3
34.7569E3
46.3425E3
57.9281E3
69.5137E3

Maximum 80 954E3 at node 18 of element 143
Minimum -23.3166E3 at node 325 of element 112

Analysis: Analysis 1

Loadcase: 1:Permanent

Results file: Slab_Design~Analysis 1.mys

Entity: Force/Moment - Thick Plate

Component (Averaged nodal): MY (Units: N.m/m)

-11.4305E3
0.0
11.4305E3
22 B861E3
34.2916E3
45 7221E3
57.1526E3

68.5831E3
80.0136E3

Maximum 80.42E3 at node 18 of element 143
Minimum 22 4547E3 at node 561 of element 198

Wood-Armer Results

Slab design will be carried out based on the Wood-Armer moments in the slab. These
results are computed from the orientation of the reinforcement assigned to the slab, so
the reinforcement capacities/details must be defined and assigned to the model before
results can be made available.

Two attributes are available from which Wood-Armer moments can be calculated, and
these are accessed from the Attributes > Wood Armer and Attributes > Design > RC
Slab Design menu items. Since we are going to carry out slab design calculations, we
will need to create and assign to the model an RC Slab Design attribute.




Simple Building Slab Design

Defining the RC Slab/Wall Reinforcement attribute

|Att"'but_eS e On the Surface reinforcement dialog choose New... from within the cell shared by
Design the ‘Stretch to fit’ row and column.
Surface
reinforcement. ..
Surface Reinforcement o
Row Column
(®) Cartesian zones () Radial zones Irsert Delste Insert Delete
Length Stretch to fit
Sietchto e
g
[
E
q
3

In its simplest form a single set of top and bottom slab reinforcement can be defined.
This can then be assigned to selected surfaces in the model, where it will stretch to fit
the extents of those surfaces that represent the concrete slab.

e On the Surface Reinforcement layout dialog, ensure the top and bottom actual cover
values are set to be 0.02

e Ensure the Angle of bars in y' from bars in x is set to be 90 degrees.
o Enter an Illustrative thickness of 0.2

e Define the bar diameter for the top and bottom reinforcement layers to be 0.02 and
ensure the spacing of bars in the top and bottom layers is 0.15

10



Viewing the Results

Surface Reinforcement Layout x
Face Actual cover Nominal cover Angle of bars in y*
from bars in x
Bottom 0.02 Actual thickness
View axis ™ -
100
Top
:
Bottom
Ly.
Row Face Layer Direction Gap Bar diameter Spacing
Top x 02 .
Top ¥ 02
Botiom Y 02
Bottom X 02
Name | SrfRnfLtL| | 2 tew)
Cancel Apply Help

e Accept the default surface reinforcement layout name of SrfRnfLt1 and click OK.

e Then click OK on the parent dialog to complete the definition.

Assigning the RC slab design attribute
e Select the whole model and drag and drop the

Surface reinforcement attribute SrfRnfLtl
from the Treeview onto the selected
Surfaces.

e On the resulting dialog accept the default
settings and click OK.

Note. Considering the surfaces selected as a single
assignment assigns the reinforcement arrangement
across the extent of all surfaces selected.
Considering each selected surface individually
inserts the defined reinforcement arrangement
within the extent of each surface.

Note. Assigning the Surface reinforcement
attribute adds a new results entity Wood Armer to
the available results.

Assign Surface Reinforcement X

Assign to points

Assign to lines

Assign to volumes

Multiple selected surfaces

(®) Consider selection as a single assignment
(O Consider each selected item individually

Crientation {reinforcement)
(®) Global axes
Local axes of surface
() specified local coordinate
<Select>

(O Reference path

Create reference path from selec

Circumferential bars for radial reinforcement

% bars

y' bars

Cancel Help

11



Simple Building Slab Design

= . . Analysis: Analysis 1

° - Loadcase: 1:Permanent

In the TreeVleW rlght Results file: Slab_Design~Analysis 1.mys
Entity: Wood-Armer - Thick Plate

click on Contours and Component (Averaged nodal): MX(B) (Units: N.m/m)

choose Properties W,
-21.0125E3

-18.0107E3 dl
. -15.0089E3
e Set the Entity as Wood- 1
. -6.00356E3
Armer — Thick Plate and g <0oi7ecs

Maximum 0.0 at node 2 of element 26

Component as MX(B), Mnimm-27.01653 stnods 450 of slement 1
click OK to close the

dialog and plot the

contours

e Click in an empty region
of the view window to
deselect the previous selection

Defining Load Combinations

Loadcases will be combined to provide the most adverse loading effects. Different
combination types are required in preparation for the RC Slab Design. This is achieved
using the Design Combination facility within LUSAS Modeller.

Combinations will be provided to EN1990:2002 for ULS Fundamental combination
(using equation 6.10), SLS Characteristic combination, and SLS Quasi-permanent
combination.

Defining a design combination

|De§9“_ The Load Combination dialog will appear. From each drop-down list, select the
esign P
Combinations following:

Set/Edit .

Combination e  From the country list select Europe.

Design Code...

e From the Design code list select EN 1990 — 2002 Buildings Recommended
Values.

Then, click OK.

[Design The Design Code Combinations dialog will appear.
Design
Combinations _ Add Permanent actions:
Generate Design
Combinations. ..

e Select the Permanent Actions tab.
e Click Add loadcases, then add Permanent, and click OK.

e Ensure that the Action type is set to G | Permanent Actions.

12



Viewing the Results

Add Variable actions:

e Select the Variable Actions tab.
e Click Add loadcases, then add Variable, and click OK.

e Set the Action type to Qi B | Imposed: Category B — office areas.

Generate combinations:

e Select the Combinations to Generate tab.

e Include ULS Fundamental Set B (Eq. 6.10), SLS Characteristic, and SLS
Quasi-Permanent.

e Ensure that Basic Combinations is selected.
e Ensure that Create envelope for each combination is selected.
e C(Click Generate combinations.

Plotting results for a design combination

e From the @ Treeview, select Envelope of ULS Fundamental Set B (Eq. 6.10)
with the right-hand mouse button and pick the Set Active option.

e Select the Minimum values option, the Force/Moment — Thick Plate entity, and
the MX component.

e Ensure Change existing drawing layers to above component is selected and
click the OK button.

Envelope: 7:Envelope of ULS Fundamental Set B (Eq. 6.10) (Min - MX)
Entity: Force/Moment - Thick Plate
Component (Averaged nodal): MX (Units: N.m/m)

-43.0731E3

-28.7154E3

14.3577E3
| 0.0

14 3577E3

28.7154E3
43.0731E3
57.4308E3
71.78B5E3

Maximum 80.954E3 at node 18 of element 143 (6:U
Minimum -48 2654E3 at node 325 of element 112 (3




| Design
RC Slab/Wall
Design...

Simple Building Slab Design

Caution. Whilst not a problem with this example, note that if you use smart
combinations with ‘derived components’ you may not obtain the expected results. The
online help provides details of such circumstances which you should fully understand
before using this facility. In this worked example, a linear primary component is being
used to create the smart combination from which the Wood-Armer values will be
computed. It will be necessary to carry out design checks using primary components in
both directions (X and Y) to ensure the most onerous combination is found.

Using the RC Slab Design facility

The RC Slab design facility enables calculation of required steel reinforcement areas
for ULS loadcases and calculation of crack widths for SLS loadcases. ULS
reinforcement design is based on calculated Wood-Armer moments whereas crack
width calculations are based on principal moments. The effective depth is computed
from the top and bottom reinforcement bar sizes and the covers provided in the RC
Slab attribute.

Caution. This example uses an irregular mesh of thick plate elements and for these
elements the results are output in global directions that, in this case, match the intended
reinforcement directions. In other modelling situations, if the elements in a model are
orientated such that their local axes vary from one another, or if an alternative
coordinate system is required, the results will need to be transformed to a consistent
direction. This can be achieved by either setting a local coordinate set or choosing an
appropriate results transformation option on a results layer property dialog prior to
opening the RC Slab Designer.

e Ensure that Europe (Eurocode | ReSkbWall Design X
recommended Values) and EN 1992-1- Country Europe (Eurocode recommended values) ~
1:2004 are sclected from the dropdown | pesigneode  [en 1892172000 5
list of countries and design codes

Partial factors for materials

. . Conerete (yc)
e Accept all other settings and click OK. .
Reinforcing steel (ys)
Coefficient for long term effects for concrete
e
Defaults 0K Cancel Help

14



| Attributes

|_Design >
RC Slab/Wall
Design...

| Design
RC Slab/Wall Design
Results...

Viewing the Results

RC Slab/Wall Design Attribute

e On the General tab select the design calculation method as Bending and in-plane
(Sandwich model / Principal stresses) and click OK to add the design attribute to

the A Treeview.

e In the C Treeview right-click on results loadcase Permanent (see note below)
and choose Set active

e Select the whole model and drag and drop the design attribute Des1 from the o
Treeview onto the selected Surfaces.

Note. The Permanent loadcase is set active because a design attribute must be added
to a loadcase and not a combination.

Note. Whilst only the General tab was visited for this example, it is possible to modify
Shear, Min/Max reinforcement, SLS & Creep properties on the other tabs of this
dialog.

Note. For 2D plate models the design calculations options are set to bending only. For
a 3D model comprising shell elements, slab design can be carried out considering in-
plane effects as well as bending.

Adding RC Slab/Wall Design Results

On this dialog, selections can be made to specify which parts of a model should be

checked for which load groups. From the resulting entry in the (X Treeview the design
check results can be viewed, and tables of results can be obtained.

15
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e In the Extent panel, select All members. RC Slab/Wall Design Results (EN 1992-1-1:2004) X
Extent
e In the Design check locations panel | @® aimembers
ensure that Averaged nodal is selected. O Visible members
O Group None
[ ] In the L()ad Groups panel press the () Reinforcement attribute Mane
Select button for ULS. O Sufsces 1741

Design check locations

e On the Select Loadcases dialog
presented, select Envelope of ULS
Fundamental Set B (Eq. 6.10) (Max) .05 —
and Envelope of ULS Fundamental Set

Averaged nodal ~

SLS - characteristic (2 loadcases selected) Select..
B (Eq‘ 6‘10) (Mln)’ then add them to the SLS - quasi-permanent (2 loadcases selected) Select..
Included list. Click OK.
Design check name Load group
e In the Load Groups panel press the ULs (1462 us ~
Select button for SLS — characteristic. Minma rinforcement -
SLS (crack control) check (7.3.4) 5LS - quasiperm... |
. OII the Select Loadcases dialog SLS.stress limits {7 2) SLS-charadEnst?c ~
Min reinforcement (7.3.2) 5LS - charactenistic |~
presented, select Envelope of SLS
Characteristic (Max) and Envelope of IR LT
SLS Characteristic (Min), then add
them to the Included list. Click OK. Name | RC Sleb/WallDesign 1 ~| (] oem
0K Cancel Apply Help

e In the Load Groups panel press the
Select button for SLS — quasi-permanent.

e On the Select Loadcases dialog presented, select Envelope of SLS Quasi-
Permanent (Max) and Envelope of SLS Quasi-Permanent (Min), then add them
to the Included list. Click OK.

e On the RC Slab/Wall Design Results dialog accept the default name of RC
Slab/Wall Design 1 and click OK to finish.

An RC Slab/Wall Design loadcase entry €5 named ‘RC Slab/Wall Design 1’ will be
added inside a Post processing folder in the C Treeview,
Viewing the Results

o In the {2 treeview right-click on the loadcase RC Slab/Wall Design 1 and select
Set Active.

o In the &= Treeview double-click on the Contours entry to edit the properties.

e Ifneeded, select OK on the warning dialog that appears.

16



Viewing the Results

. Loadcase: 14:RC Slab/Wall Design 1 (EN1992-1-1 (Eurcpe) | Nodes)
(] Ensure that Entlty Entity: RC Slab/Wall - EN 1992-1-1:2004
. Component (Averaged nodal): Util(Max)

1s set to RC .

0.494872

Slab/Wall — EN brren
1992-1-1:2004 2.4743

2.96823
and component 846411

set to Util(Max) i /45305

. Maximum 4.87273 at node 18 of element 254
and Chck OK Minimum 0.418879 at node 3 of element 66

It can be seen that the
maximum utilisation
of 4.87 is above the
single point support
representing the
central column. This
will be investigated further.

e In the C treeview right-click on the loadcase RC Slab/Wall Design 1 and select
Show Results

e  On the Summary tab click the Util(Max) label at the top of the last column twice
to sort by utilisation value in descending value.

RC Slab/Wall Design Results (EN 1992-1-1:2004) [u] X
SectioniD: Al = SurfacelD: Al o Loadcase: nla Face/Direction:  n/a Help
Detailed results for selected row.. Display only results for selected surfaces Select surfaces in model Select elements in mods!

Summary Enveloped results Section definitions ULS (6.1 & 6.2) Min-max reinforcement SLS (crack control) check (7.3.4) SLS stress limits (7.2) Min reinforcement (7.3.2)

Section Surface Element Node Uti(ULS) Util(Asmin Asmax) UtiI(CC) UtiI(SLS.S) Util(AsCC) Util(Max)
4 | o5 | 8 | asm | 049 | s | 15 | TR I
1 1 18 4.793 0419 1.164 1.533 0.168 4.793
1 2 143 18 4.786 0419 0.787 0.975 0.168 4.786
1 3 175 18 4.781 0419 0.850 1.074 0.168 4.781
1 4 239 453 4.086 0419 0.648 0.747 0.168 4.086
1 2 103 453 3.978 0419 0.648 0.743 0.168 3.978
1 2 110 437 2.950 0419 0.202 0.19%9 0.168 2.950
1 4 239 732 2.664 0419 0.347 0.436 0.168 2.664
1 2 103 345 2.53% 0419 0.336 0.429 0.168 2.53%
1 3 202 34 2.530 0419 0.337 0.445 0.168 2.530
1 2 123 2 2.454 0419 0.208 0.389 0.168 2454
1 1 26 2 2432 0419 0.214 0.392 0.168 2432
1 1 41 34 2389 0419 0338 0446 0.168 2389
1 4 254 360 2269 0419 0613 0748 0.168 2269
1 4 254 524 2265 0419 0452 0667 0.168 2265
1 2 143 360 2241 0419 0499 0584 0.168 2241
1 3 175 524 2236 0419 0.306 0513 0.168 2236
1 3 175 35 2234 0419 0499 0581 0.168 2234
1 2 143 33 2225 0419 0333 0512 0.168 2225
1 1 81 35 2202 0419 0659 0.795 0.168 2202
1 1 81 33 2182 0419 0498 o711 0.168 2182

From the summary table it can be seen that:
e The maximum utilisations are due to the Util(ULS) check.
e The Util(CC) and Util(SLS,S) checks also have utilisations greater than 1.0.

These results are to be investigated further by selecting the appropriate tabs.

17



Simple Building Slab Design

Viewing detailed results for a slab location
Util(ULS) Check results

e On the main RC Slab/Wall Design Results summary table select the ULS (6.1 &
6.2) tab.

o Expand the width of the table and sort the Util(Max) column in descending order.

It can be seen that the peak values are due to the shear check Util(VRdc).

RC Slab/Wall Design Resuits (EN 1992-1-1:2004) o X
SectioniD: Al v SurfacelD: Al v Loadcase: Al v Face/Direction: Al ~ Help
Detailed results for selected row. Display only results for selected surfaces Select surfaces in model Select elements in model

Summary_Enveloped results_Section definitions ULS (6.1 & 6.2) Min-max reinforcement SLS (crack control) check (7.34) SLS stress limits (7.2) Min reinforcement (7.3.2)

Secion Surocs Soment Nose Condease Focerocion _ Ulhe) Uiro) Uise  UiRaS  UsVRamen hev il Uitien
To | 7Enwolpe of ULS Fundam o577 sa75 5 ST |

: 7 254 16 7Envelopeof ULS Fundam. | Borton 0000 0000 057 w073 : : 170
: . 251 18 7EmekpeorULSFundam | TopK 1008 oa2 0sm 107 - - om0
: . 251 16 7EnvelopeofULS Fundom. | Boton 0000 0000 057 107 - - om0
: . 251 16 7EnvelopeofULS Fundom.. | Botomy 0000 0000 057 om0 - - om0
: . 25t 8 7EmekpeciULsFundom. | TopK 1008 oa o5 s - - om0
: . B 6 7EmepeciULsFundom. | Topy 107 0sss 05 om0 - - sam
: . B 6 7EmepeciULsFundom. | TopK 1008 os2 0sms sam - - o
: . Y 16 7EnvelopeofULS Fundom.. | Botony 0000 0000 057 o7 - - o
: . B 16 7EnvelopoofULS Fundom. | Goton 0000 0000 057 o - - o
' . B 16 7Emekopeof UsFundom.. | Topy 1097 0385 0ses o - - o
) P 254 6 7EmekpectULsFundom | Topy 097 03 0sms o - - wom
: . 254 16 7EnvelopoofULs Fundom. | Boton 0000 0000 057 s - - e
: . 254 18 7EmekpecfULsFundam | TopK 1008 i 0sms - -

: . 254 18 7Envelopo ofULs Fundam .| Botomy 0000 0000 0sm - -

: . 254 18 7EmokpecfULsFundam | TopK 1008 oa osms aan - - aam
: . 254 18 7EmokpeofULs Fundam | Topy 107 oass 0sms 167 - - 17
: . 251 18 7EmekpeofULs Fundam | Topy 107 0ass 0sms wo73 - - 17
: . 251 16 7EnvelopeofULS Fundam. | Botomy 0000 0000 osm w073 - - 17
: . 251 16 7EnvelopeofULS Fundom. | Boton 0000 0000 057 om0 - - o7

Util(CC) check results

e On the main RC Slab/Wall Design Results summary table select the SLS (crack
control) check (7.3.4) tab.

o Sort the Util(CW) column in descending order.

RC Slab/Wall Design Results (EN 1992-1-1:2004) [u] X
SectioniD: Al v SurfacelD: Al o Loadcase: Al ~ Face/Direction: Al v Help
Detailed results for selected row. Display only results for selected surfaces Select surfaces in model Select elements in model

Summary Enveloped results Section definitions ULS (6.1 & 6.2) Min-max reinforcement SLS (crack control) check (7.3.4) SLS stress limits (7.2) Min reinforcement (7.3.2)

Section Surface Element Node Loadcase Face/Direction  Eceff [GPa] 5 [MPa] Util(CW)
T O e e P S BT TS A I
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 516.143 1.165
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 516.143 1.165
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 516.143 1.165
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 516.143 1.165
1 1 81 18 13:Envelope of SLS Quasi-.. TopX 10.9375 515.964 1.164
1 1 81 18 13:Envelope of SLS Quasi-... TopX 10.937% 519.964 1.164
1 1 81 18 13:Envelope of SLS Quasi-... TopX 10.937% 519.964 1.164
1 1 81 18 13:Envelope of SLS Quasi-.. TopX 10.9375 515.964 1.164
1 1 81 18 13:Envelope of SLS Quasi-.. TopX 10.9375 515.964 1.164
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.174 1.016
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.174 1.016
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.174 1.016
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.174 1.016
1 4 254 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.174 1.016
1 1 31 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.018 1.016
1 1 81 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.018 1.016
1 1 81 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.018 1.016
1 1 81 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.018 1.016
1 1 31 18 13:Envelope of SLS Quasi-.. TopX 10.9375 451.018 1.016
1 4 254 18 13:Envelope of SLS Quasi-.. TopY 10.9375 428964 0.972
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Viewing the Results

Investigating Util(CC) results further

e Select the first row in the SLS crack control check table and then click the Detailed
results for selected row button at the top of the dialog. Double clicking the row
will also give the detailed results.

o In the Design Calculation Viewer select the SLS (crack control) check (7.3.4) and
scroll through the results to view data relating to bar spacings and utilisation.
Failures are highlighted in red text.

From the calculations it can be seen that for crack width calculations for the top face of
the slab, the reinforcement spacing limited has been satisfied in both the x and y
directions, but the crack width utilisation exceeds 1.0 in the x-direction.

Calculation of crack width

Crack width

Wi = Srmax ' (Esm — €em) = 137.57 - (2.54061E-3) = 0.349512 mm
Allowable crack width Wi = 0.3 mm
Crack width utilisation Util(CW) = 1.16504

Cracks controlled by the y direction reinforcement

Moment most closely aligned to y axis M = 83.2174E6 Nmm
Angle of moment a=46.24°

e  Close the Design Calculation Viewer.

Util(SLS,S) check results

e On the main RC Slab/Wall Design Results summary table select the SLS stress
limits (7.2) tab.

e  Sort the Util(Max) column in descending order.

The maximum utilisation is due to the check Util(sigmaXS).
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RC Slab/Wall Design Results (EN 1992-1-1:2004) o X
SectionlD: Al ~ SurfacelD: Al v Loadcase:  All ~ Face/Direction:  All v Help
Detailed results for selected row... Display only results for selected surfaces Select surfaces in madel Select elements in model
Summary Enveloped results Section definitions ULS (6.1 & 6.2) Min-max reinforcement SLS (crack control) check (7.3.4) SLS stress limits (7.2) Min (73.2)
Section Surface Element Node Loadcase Face/Direction  Eceff [GPa] Util{sigma$) Util(sigmaC) Util(Max)
S S B T e e T A R T T |
1 4 254 18 10:Envelope of SLS Charact. TopX 10.9375 1534 0.000 1534
1 4 254 18 10:Envelope of SLS Charact. TopX 10.9375 1534 0.000 1.534
1 4 254 18 10:Envelope of SLS Charact. TopX 10.9375 1.534 0.000 1.534
1 4 254 18 10:Envelope of SLS Charact. TopX 10.9375 1.534 0.000 1.534
1 1 81 18 10:Envelope of SLS Charact. TopX 10.9375 1533 0.000 1533
1 1 81 18 10:Envelope of SLS Charact. TopX 10.9375 1.533 0.000 1.533
1 1 81 18 10:Envelope of SLS Charact. TopX 10.9375 1.533 0.000 1.533
1 1 81 18 10:Envelope of SLS Charact. TopX 10.9375 1.533 0.000 1.533
1 1 81 18 10:Envelope of SLS Charact. TopX 10.9375 1533 0.000 1533
1 4 254 18 10:Envelope of SLS Charact. TopY 10.9375 1522 0.000 1.522
1 4 254 18 10:Envelope of SLS Charact. TopY 10.9375 1.522 0.000 1.522
1 4 254 18 10:Envelope of SLS Charact. TopY 10.9375 1522 0.000 1.522
1 4 254 18 10:Envelope of SLS Charact. TopY 10.9375 1522 0.000 1522
1 4 254 18 10:Envelope of SLS Charact. TopY 10.9375 1522 0.000 1.522
1 1 81 18 10:Envelope of SLS Charact. TopY 10.9375 1.521 0.000 1.521
1 1 81 18 10:Envelope of SLS Charact. TopY 10.9375 1.521 0.000 1.521
1 1 81 18 10:Envelope of SLS Charact. TopY 10.9375 1521 0.000 1521
1 1 81 18 10:Envelope of SLS Charact. TopY 10.9375 1.521 0.000 1.521
1 1 81 18 10:Envelope of SLS Charact. TopY 10.9375 1.521 0.000 1.521
1 3 175 18 10:Envelope of SLS Charact. TopY 10.9375 1.074 0.000 1.074

e  Close the RC Slab/Wall Design Results.

Viewing the contour plots

The contour plots for the results of interest will now be viewed. This is best done using
the Design contours option that shows values of utilisation from 0.7 to 1.0 and above.

e In the =¥ Treeview double-click on the contours layer.

e  Ensure the Entity is set to RC Slab/Wall — EN 1992-1-1:2004 and the component
is set to Util(Max).

e Select the Appearance tab and select the Design option. Press OK.

The contour plot is as shown below.
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Viewing the Results

Loadcase: 14:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Util(Max)

0.7
- 0.8

0.9

1.0 P
Maximum 4.87273 at node 18 of element 254 4
Minimum 0.418879 at node 3 of element 66 N

1]
=1 2~
Similarly, the plots of interest for Util(ULS), Util(CC) and Util(SLS,S) follow:
Util(ULS)
Loadcase: 14:RC Slab/Wall De5|gn 1 (EN‘I 992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 199211
Component (Averaged nodal): UtJI(ULS]
07
- 0.8
0.9
1.0 P
Maximum 4.87273 at node 18 of element 254 4
Minimum 0.222904 at node 5 of element B6
71
- 1
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util(cc)

Loadcase: 14:RC Slab/Wall Design 1 (EN1992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2004
Component (Averaged nodal): Util(CC)

0.7
- 0.8
0.9
1.0

Maximum 1.16504 at node 18 of element 254
Minimum 1.00227E-3 at node 853 of element 231

Util(SLS,S)

Loadcase: 14:RC Slab/Wall Design 1 (EN‘I 992-1-1 (Europe) | Nodes)
Entity: RC Slab/Wall - EN 1992-1-1:2

Component (Averaged nodal): UhI(SLS S}
0.7

- 0.8
09
1.0

Maximum 1.53448 at node 18 of element 254
Minimum 1.83445E-3 at node 853 of element 231

Al

Further contour plots are available which can provide additional information. For

example, the plot of Util(CC) can be separated into top and bottom checks, Util(CC(T)
and Util(CC(B)) respectively as shown below.
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util(cc(T))

Loadcase: 14:RC Slab/Wall Design 1 (ENT 99211 (Europe) | Nodes)

Entity: RC Slab/Wall - EN 1992-1-1:2
Component (Averaged nodal): UtJI(CC(T))

0.7
Y
0.9
10

Maximum 1 16504 at node 18 of element 254
Minimum 0.0 at node 59 of element 27

util(cc(B))

Loadcase: 14:RC Slab/Wall Demgn‘l (EN‘] 992-1-1 (Europe) | Nodes)

Entity: RC Slab/Wall - EN 1992-1-1:
Component (Averaged nodal): UtJI(CC(B))

0.7
- 0.8
0.9
1.0

Maximum 0.307079 at node 395 of element 109
Minimum 0.0 at node 18 of element 81

From this it can be seen that the Util(CC(T)) is critical over the central column support

while the utilisation of Util(CC(B)) is less than 1.
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Simple Building Slab Design

Notes regarding utilisations obtained

The objective of this example is to demonstrate the use of the RC slab/wall design
facility. To this end the modelling of the structure has been somewhat simplified.

A more accurate model could be considered by the inclusion of details such as column
heads or drop panels as necessary. Also, the modelling approach could be developed to
include the columns themselves or to provide constraint equations to reflect behaviour
more accurately at the head of the column.

In addition, the plate/shell elements in LUSAS are high performance. Therefore, the
effects of stress concentration may be considerable, as is the case in this example. As
with any finite element software, engineering judgement should be applied when
analysing the results.

As a result of this there are very high utilisations at and around the support locations.
Whilst some increase to the area of reinforcement is required to particular regions the
previous comments should be noted when considering the reinforcement requirements
near the supports.

Save the model

El Save the model file.

Note. All the Slab Designer inputs are saved to the model and will be saved when the
model is saved. All load combinations, envelopes, and graph datasets, if defined when
processing results, are also saved and therefore do not have to be re-created if the
model is amended and a re-analysis is done at a later date.

This completes the example.

Element types and orientation of results

The orientation of the slab reinforcement is aligned with the results axes. In this
example thick plate elements are used whose results axes are always transformed to the
global directions.

Caution. If shell elements are used (when they may be appropriate) the results must
be transformed into a consistent direction coinciding with the intended direction of the
reinforcement. Note that by default shell results are orientated along the local element
axes.

24



Discussion

o The mesh orientation can be viewed from the Treeview by selecting Mesh >
Properties and selecting the Show Element Axis option. Press OK to apply
changes.

e Results transformations can be applied using the Transform Set... button on a
results layer’s Properties dialog. Selecting Global axes will transform local
element results into the global axes system. Other options are available.

e Global results are indicated by the uppercase X, Y and Z in the component names,
whereas lowercase x, y and z (when seen) are used to denote local results or
transformed results.

Element density and results obtained

If the Teaching and Training version of LUSAS was used to carry out this example
with a reduced default mesh density of 4 divisions per line a reduced accuracy of
results will be obtained.

In general, more accurate results are obtained when using more line mesh divisions and
hence more elements when modelling slabs of this type. Care should always be taken to
use an appropriate number of elements together with a possible refinement of the mesh
in areas of interest in order to obtain the best results.
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